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About this document
References to Picture Perfect 4.5 for AIX are subject to availability -- currently planned for late 2010.

This manual provides instructions for the installation, configuration, and operation of the Graphics Monitoring 
and Control software.

There is also information describing how to contact technical support if you have questions or concerns. 

To use this document effectively, you should have the following minimum qualifications:

• a basic knowledge of your access control system; and
• a basic knowledge of general concepts associated with graphical editors. 

Read these instructions and all ancillary documentation entirely before installing or operating this product. The 
most current versions of this and related documentation may be found on our website. 

Note:  A qualified service person, complying with all applicable codes, should perform all required hardware installation. 

Conventions used in this document

Notational and typographical conventions

The following conventions are used in this document: 

Safety terms and symbols

These terms may appear in this manual:

Cautions identify conditions or practices that may result in damage to the equipment or other property. 

Warnings identify conditions or practices that could result in equipment damage or serious personal injury. 

Bold Menu items and buttons. 

Italic Emphasis of an instruction or point; special terms.

File names, path names, windows, panes, tabs, fields, variables, and other GUI elements. 

Titles of books and various documents. 

Monospace Text that displays on the computer screen.  

Programming or coding sequences. 

Blue italic Hyperlinks to cross-references, related topics, and URL addresses. 

CAUTION:  Improper use may cause equipment damage. 

WARNING:  Improper use could cause equipment damage or serious personal injury. 
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Related documentation
If you want to investigate related topics, these other documents may prove helpful: 

• GE Security Picture Perfect 4.5 User Manual 
• GE Security Picture Perfect 4.5 Installation Manual

Contacting technical support
For assistance installing, operating, maintaining, and troubleshooting this product, refer to this document and 
any other documentation provided. If you still have questions, you may contact technical support during 
normal business hours (Monday through Friday, excluding holidays, between 8 a.m. and 7 p.m. Eastern Time).

GE Security

United States: +1 888 437 3287

Asia: 852 2907 8108

Australia: 61 3 9259 4700

Europe: 48 58 326 22 40

Latin America: 503 885 5700
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This chapter provides an overview of the Graphics Monitoring and Control 
system and instructions for installing it.

In this chapter: 

Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6
Installing the software. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7
Quick Start Guide . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17

Chapter 2 Getting started
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Overview
Graphics Monitoring and Control allows you to use site maps of your premises and associate symbols (graphic 
images or icons) to object types, such as doors, readers, micro controllers, or digital inputs. When the condition 
of a device property changes, one or more of the symbols changes its appearance based on the condition, if 
configured to do so.

The following terms are used throughout this manual and are defined as follows:

Graphics Monitoring and Control consists of four applications that allow you to edit, link, and monitor 
graphics maps. These applications are:

• Graphics Parameters allows you to set parameters for a graphics map. You can define the number of 
layers that can be used to separate object types and the rate at which links blink to identify a graphics 
map in alarm.

Refer to Graphics Parameters on page 19 for more information.

• Symbol Editor allows you to associate object types, such as doors, readers, digital inputs, or micro 
controllers with icons representing properties and conditions. Use the Symbol Editor to create, delete, 
save, upload, and download symbol schemes. 

Refer to Creating symbols on page 29 for more information.

• Graphics Editor allows you to place symbols representing devices such as doors, readers, digital 
inputs, or micro controllers on graphics maps. For example, start with a floor plan and place symbols 
on the map to indicate their location, and then link these symbols to a physical device. In addition, you 
can add text to create labels and print the graphics maps. 
The Graphics Editor also allows you to import .gif, .jpg, .jpeg, or AutoCAD .dxf files to be used in 
creating your graphics maps. 

Refer to Creating graphics maps on page 41 for more information.

Table 1. Glossary of terms

Term Definition

Command Group Multiple devices of the same type configured to be controlled by a single icon. 

Condition The possible values for a device property, such as set or reset

Graphics map A collection of images/drawings, symbols, text, links, and command groups that form a graphical 
representation of the physical or logical layout of a site.

Icon A graphic image representing a condition of a device property. 

Link A bridge or connection between two graphics maps.

Object type Devices specific to your system, such as micro controllers, doors, readers, or digital inputs.

Property A characteristic of a device, such as a door that has been forced open. The properties that display are 
appropriate for the selected object type.

Symbol scheme A collection of graphic images or icons representing each condition of each device property. 

Symbol A component of a symbol scheme consisting of a single graphic image or icon. The icon represents a 
specific condition of a device property.
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• Graphics Monitor provides a graphical view of the premises and allows an operator to locate alarms or 
events as they occur, such as a door held open alarm. Operators can issue commands, such as locking 
and unlocking doors.

Refer to Monitoring graphics maps on page 73 for more information.

Installing the software
Graphics Monitoring and Control is an optional software package, designed to work in conjunction with your 
access control system. It can be installed at the same time the host system is being installed or any time 
thereafter. 

Minimum system requirements

Licensing the software

Graphics Monitoring and Control is an optional software package and requires the customer to request a 
license from GE before use. If you are installing this package at the same time as your host system, the license 
may already be included. Refer to the appropriate host section below for instructions on obtaining a license if it 
was not included in your initial access control system.

Installing Graphics Monitoring and Control on Picture Perfect

Software license key

Your existing Picture Perfect license key may need to be updated to include GRAPHICS_MAPS. If you 
experience problems with your license key, execute /cas/bin/skver which will either verify that you 

Table 2. Minimum system requirements for a Picture Perfect system

Server Client

Operating system: One of the following:
• IBM AIX 6.1
• Red Hat Enterprise Linux 5.3

One of the following:
• Windows Vista SP2
• Windows XP SP3

Free disk space: 200 MB in one of the following file systems:
• /usr

• /var

• /home
• / 

200 MB in the C:\ directory

Software: Picture Perfect 4.5 (base patch level 0) One of the following:
• Internet Explorer 6.0 with Service Pack 1 or 

later
• Internet Explorer 7.0 
• Firefox: 3.0

In order to display Chinese language fonts:
• MS Office font: Arial Unicode MS

Memory: 2 GB RAM 2 GB RAM
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have a valid license key, or provide you with information regarding the problem. If the list of licensed products 
includes GRAPHICS_MAPS, then your system is licensed properly.

If not, contact GE Security Customer Support as follows. Have the barcode from the software box and machine 
seed key available.

• Telephone: 1-888-437-3287, option 5
• Email: gesecurity.licenses@ge.com

You will also have to provide the following information:

• End-user company name, address, and return phone or fax number
• Business Partner name and address
• Sales order number

Installing the software

Follow these steps to install Graphics Monitoring and Control after the Picture Perfect base system has been 
installed:

Note:  In an Enterprise system, only install Graphics Monitoring and Control on the network subhosts, not on the network host.

To install the Graphics Monitoring and Control package:

1. Log on as ppadmin and open a terminal window.

2. Type the following to shut down Picture Perfect: 

. /cas/bin/profile  

rc.pperf -k 

3. Switch users to root by typing the following command.

su - 

Enter your root password and then press  .

4. Insert the Picture Perfect v4.5 Installation DVD into your server. Wait for the DVD ROM LED to stop 
blinking before proceeding.

5. Unmount the DVD by typing the following command:

umount /media/pp45 

6. Mount the DVD by typing the following command:

Linux

mount /dev/dvd /media 

Enter

Enter

Enter

Enter

Enter

Enter
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AIX

mount -v cdrfs -r /dev/cd0 /mnt 

7. Change to the root directory by typing cd / .

8. To display a list of installation options, type:

Linux

/media/Linux/INSTALL -o 

AIX

/mnt/AIX/INSTALL -o 

You will receive messages similar to those shown below, followed by a list of packages:

-----------------------------------------------------------------------------

         Picture Perfect CD-ROM Installation - 4.5 04/10/09
            Copyright (C) 1989-2009 GE Security, Inc.

------------------------------------------------------------------------------

The following BASE OPTIONS product(s) are available:

Prod #  Name and Descriptions

------  ---------------------
0       base          Picture Perfect Base package 
1       graph         Picture Perfect Graphics Monitoring and Control package 
2       image         Picture Perfect Imaging package 
3       impexp        Picture Perfect Import/Export package 
4       netlan        Picture Perfect Network System - Host package 
5       pprs          Picture Perfect Redundant System package 
6       subhost       Picture Perfect Network System - Subhost package 
7       tours         Picture Perfect Guard Tours package 

Enter product number(s), separated by ',' to select, 'q'  to quit: 

9. Type the number of the Graphics Monitoring and Control package, 2, and press .

Your package selection will now be displayed, and you will be asked to confirm.

You have selected the following product(s):

1 graph Picture Perfect Graphics Monitoring and Control package
Is this correct (y/n)? [y] 

10. To install the package, type: y 

The package installation begins and messages similar to the following display. 

Installing graph...

Picture Perfect Multi-package Installation - 4.5 04/10/09

Enter

Enter

Enter

Enter

Enter

Enter
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Copyright (C) 1989-2009 GE Security, Inc.

Installing from image in /media/Linux/pp ...

Do you want to install the Picture Perfect GRAPH Package (y/n)? [y]

11. To continue the installation, type: y 

The installation continues and messages similar to the following display:

Picture Perfect NLS Text Save - 4.0 01/16/06

Copyright (C) 2000-2006  GE Security

Tue Sep  8 08:04:55 EDT 2009

This package has no nls or help files to save...

-----------------------------------------------------------------------------
     Picture Perfect GRAPH Installation Procedure - Version 4.5 04/13/09

             Copyright (C) 1989-2009 GE Security, Inc.

-----------------------------------------------------------------------------

The installation performs the following steps:

    1.  Ensures Picture Perfect packages installed at proper patch levels.
    2.  Determines if there is adequate disk space.

    3.  Loads the Graphics Monitoring And Control Software.

    4.  Creates the necessary database tables.

When this script asks you questions, a default answer is shown in brackets

next to the question. To use the default answer, press <Enter> in response

to the question.  Otherwise, type one of the other suggested responses.
([n] means 'no'; and [y] means 'yes').

Continue the installation (y/n)? [y]

12. To continue the installation, type: y 

The installation continues and messages similar to the following display:

Starting the Informix database.. [Done]

##########################################################################

#                                                                        #
#          Size the database for Graphics Monitoring And Control         #

#                                                                        #

##########################################################################

Enter

Enter
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   Choice   Size(MB)   Description
   ------   --------   -----------

      1        200     Small - not using AutoCAD drawings

      2        500     Medium - using AutoCAD drawings, maximum 250 maps

      3       1000     Large - using AutoCAD drawings, maximum 500 maps
      4       4000     Very Large - using AutoCAD drawings, more than 500 maps

      5                Cancel installation

Choose the size for the database :  [1]

13. Based on the description, choose the size you estimate you will need for your database, from 1 to 4, or 
choose 5 to cancel out of the installation.

According to your choice, messages, similar to the following, display the size required for your 
database and you are asked to confirm:
 
Selected database sizing: 

Data space size: 20 MB 
Blob space size: 180 MB 
Total size : 200 MB

Do you wish to use these sizes (y/n) [y] 

14. To accept the sizing, type: y   
Next, you will choose the filesystem in which you want the Graphics Monitoring and Control database 
to reside. Messages, similar to the following, display the amount of space available in each filesystem 
displays so you can compare to the size required in the previous step. 

############################################################################

#                                                                          #
#  Select the filesystem for the Graphics Monitoring And Control database  #

#                                                                          #

############################################################################

   Choice       Filesystem      Size (MB)

   ------       ----------      ---------
      1         /usr            4899

      2         /var            4190

      3         /home           513
      4         /               4256

Choose the filesystem for the database :  [1]

Note:  The recommended filesystem is the default: /usr

15. Based on the size in MB, choose the filesystem you want to use, from 1 to 4.

You are asked to confirm:

CAUTION:  The Graphics Monitoring and Control database table files, graphdbs and graphbbs, reside in the 
selected file system, for example: /usr/informixdb/graphdbs 
Do NOT remove these files or you will have to re-install the operating system. 

Enter
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Selected file system: /usr

Do you wish to use this file system (y/n) [y] 

16. To accept the filesystem, type: y   
Messages similar to the following display:

Reading Graphics Monitoring and Control files from media.

This may take several minutes.

Reading Graphics Monitoring and Control files from media...

The files have been read from the media.

No errors detected

Graphics Database location is /usr/informixdb

Creating directory for Graphics database files.

Creating Graphics database files.

Setting permissions & ownership on Graphics database files.

Creating directory for Graphics database files (N/A).

Creating Graphics Data Space with size of 512000 KB.

Verifying physical disk space, please wait ...

Space successfully added.

** WARNING **  A level 0 archive of Root DBSpace will need to be done.

Backing Up databases.

Archive to tape device '/dev/null' is complete.

Program over.

Creating Graphics database apollo.

Granting Graphics database access to root...

Creating Graphics database tables...

Installing stored procedures...

Activating logging on the graphics spaces...

Installing Avatar client meta-data (applications and permissions)

Installing Graphics Monitoring and Control meta-data

Enter
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Installing Graphics Monitoring and Control pre-defined symbols

The Graphics Monitoring and Control Package was successfully installed.

Checking if need to update nls files...

Picture Perfect NLS Check - 4.5 04/10/09

Copyright (C) 2000-2009 GE Security, Inc.

Tue Sep  8 10:13:50 EDT 2009

No nls files for graph package

Running /cas/bin/fixperm on /tmp/graph.perm file...

No errors detected

/cas/bin/fixperm finished.

Installing desired BASE_OPTIONS product(s) was successful.

The Installation has completed.

The system needs to be rebooted for the changes to take effect.

Reboot the system (y/n)? [y]

Note:  If you need to restore the database, use the restore.sh utility.

17. The Graphics Monitoring and Control installation is complete. Press  to reboot the system before 
continuing to the next section.

Enter
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Configuring Picture Perfect

After you successfully install the software, the System Administrator permission record automatically updates 
to provide access to the Graphics Monitoring and Control application. Any other permission records that you 
want to provide access must be updated to include Graphics Monitoring and Control applications prior to using 
the package.

To update permissions:

1. Log on to Picture Perfect as install.

2. From the Primary menu, select Control, Operators, then Permissions tab

3. Click Find to locate the permission record that you want to update. Note the System Permission 
Profile associated with this record. 

Figure 1. Operators window; Permissions tab

4. Click the System Permissions Profiles tab and click Find to locate the system permission profile 
record that is assigned to the permission that you are updating.
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Figure 2. System Permissions Profiles window

If the Graphics Monitoring and Control package was installed successfully, the Graphics Monitoring 
and Control forms will appear on the list of Page Level Permissions.

5. Select the appropriate permission for each of the forms: Graphics Monitor, Graphics Editor, Symbol 
Editor, and Graphics Parameters. For example, you may want a guard to be able to view the Graphics 
Monitor as illustrated in Figure 2.

6. Click Save.

7. Log off of Picture Perfect and log back on as an operator with the updated permission.

The following Graphics Monitoring and Control menu items will now be available, depending on the 
permission granted to the operator:

Table 3. Graphics Monitoring and Control menu items

Picture Perfect primary navigation menu item Graphics Monitoring and Control menu item

Monitor Graphics Monitor

Configuration Graphics Editor

Configuration Symbol Editor

Setup Graphics Parameters
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8. To get started, refer to the following sections of this manual:

• First, use Graphics Parameters to define system wide settings for your maps. See Chapter 3.
• Next, use the Symbol Editor to create a symbol scheme for each object type. A symbol scheme is a 

collection of icons representing the different conditions for each property associated with that 
object type. See Chapter 4.

• Next, use the Graphics Editor to create maps, place the symbol schemes on the maps to graphically 
indicate their location, and link the symbol schemes to the device records in the database. See 
Chapter 5.

• Finally , use the Graphics Monitor to view alarm conditions, represented by the symbols on the 
maps, and to issue associated commands. See Chapter 6.
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Quick Start Guide

Define system wide settings for maps
Chapter 3 Graphics Parameters

Create symbol schemes
Chapter 4 Creating symbols

Import images or drawings for map background
Chapter 5 Creating graphics maps

Place symbol schemes on maps and link to devices
Chapter 5 Creating graphics maps

Respond to alarms and issue commands
Chapter 6 Monitoring graphics maps
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This chapter describes how to set parameters that affect the behavior of the 
Graphics Monitoring and Control software and its capabilities.

In this chapter: 

Introduction. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20
Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21
About Graphics Parameters . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22
Using Graphics Parameters . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24

Chapter 3 Graphics Parameters



Picture Perfect 4.5 Graphics Monitoring and Control
User Manual

20

Introduction
This feature allows you to set parameters, such as the number of layers that can be used to separate device 
types, or the blink interval of a link in alarm. You can also change priorities of object type properties/conditions 
when using the Overlay technique of creating a symbol scheme. 

Table 4 lists the steps needed to implement new settings and references where you will find detailed 
instructions to complete these tasks. 

Table 4. Task overview

Change the settings. Refer to Using the Settings tab on page 24 for more 
information. 

Change the priority of a Property/Condition if you have configured a symbol to 
display by priority. Refer to Using the Property Condition Priorities tab on 
page 25 for more information.

Assign a default map to an operator. Refer to Using the Operator Settings tab on 
page 26 for more information.
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Overview
Use Graphics Parameters to set the following parameters:

• Blink Interval: The Blink Interval is the rate in milliseconds between blinks on a link or a link area 
when a child map has a symbol in alarm. Set this parameter to the number of milliseconds allowed 
between blinks. See Figure 4 on page 24.

Note:  This setting only affects links, not animated icons.

• Number of Layers: Layers may be used when you create maps to separate the types of devices 
represented on a map. For example, you can have a background layer as well as a layer for micro 
controllers, another for readers, and another for doors. You can also choose to maintain layers when 
you import AutoCAD drawings. Set this parameter to the number of layers that can be used to separate 
device types. See Figure 4 on page 24.

• Auto-Launch Displays in New Window: Use this setting to launch a new Graphics Monitor window 
when an alarm that has an associated map is selected on the Alarm Monitor. Otherwise an existing 
window is used. See Figure 4 on page 24.

• Property Condition Priorities: You can change the display priority of device condition values. The 
settings are used if you choose to display the symbols on your maps by highest priority as described on 
page 37. See Figure 5 on page 25.

• Operator Settings: A default map can be selected to display when an operator opens a viewer window. 
See Figure 6 on page 26.

Once a setting is changed, use the Save  button to save it for the remainder of the session.  

Use the Upload   button to permanently save the setting and make it available to other users.

These settings are used with the Graphics Editor when creating graphics maps and the Graphics Monitor when 
viewing graphics maps. Refer to Creating graphics maps on page 41 for more information.
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About Graphics Parameters
To display Graphics Parameters, follow these steps:

1. From your host system, open Graphics Parameters.

• Picture Perfect: From the Setup menu, select Graphics Parameters, or select the Graphics 
Parameters icon from the toolbar.

The Graphics Parameters window displays as shown in Figure 3.

Figure 3. Graphics Parameters window

Tabs

Title bar

Tool bar

Menu bar
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Table 5. Graphics Parameters window

Element Description

Title bar Displays the name of the application: Graphics Parameters. 

Menu bar Provides access to the following menus: File, Help 
For more information, see Table 6 and Table 7.

Save Saves a setting to the local computer for this session. To publish the setting to the database for use in 
future sessions and to make it available to other users, the setting must be uploaded to the database. 
Note: Operator settings are automatically uploaded to the database when you click Save.

Upload Uploads a modified setting to the database.
If no change has been made or if the setting is the same as the one that existed at the time of the last 
upload, this button is disabled.

Reset Reverts the setting back to that which was last uploaded or saved.

Table 6. Graphics Parameters File menu

Menu item Description

Save Saves a setting to the local computer for this session. To publish the setting to the database for use in 
future sessions and to make it available to other users, the setting must be uploaded to the database. 
Note: Operator settings are automatically uploaded to the database when you click Save.

Upload Uploads a modified setting to the database.
If no change has been made or if the setting is the same as the one that existed at the time of the last 
upload, this button is disabled.

Reset Reverts the setting back to that which was last uploaded or saved.

Table 7. Graphics Parameters Help menu

Menu item Description

Online Help Launches the online help page specific to Graphics Parameters. Click Show to display the Contents pane 
which allows you to navigate the entire Graphics Monitoring and Control online help system.

User Manual Opens the Graphics Monitoring and Control User Manual in electronic format.
Note: Adobe Acrobat version 5.x or higher must be installed to view the manual online.
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Using Graphics Parameters
Using the Settings tab

Figure 4. Graphics Parameters window: Settings tab 

Table 8. Graphics Parameters: Settings tab fields and description 

Field name Description

Blink Interval Set this parameter to the number of milliseconds allowed between blinks on a link when a child display 
has a symbol in alarm. This setting only affects links, not animated icons. 

Number of Layers The number of layers that may be used when creating a map. Layers allow you to segregate the types of 
devices on the map; for instance, you can choose to view only the layer containing micros. 

Note:  If the number entered is outside the range defined by the Min/Max values, it appears in red. This 
indicates an invalid value, and the Save and Upload buttons are disabled. 

Auto-Launch 
Displays in New 
Window

Set to Yes to launch a new Graphics Monitor window when an alarm that has an associated map is 
selected on the Alarm Monitor. Otherwise an existing window is used. 

Min The minimum number that can be assigned to the selected field. This value is automatically populated 
when a field is selected; if no field is selected, this value is blank.

Max The maximum number that can be assigned to the selected field. This value is automatically populated 
when a field is selected; if no field is selected, this value is blank.

Type The type of entry you can make in the Value field, either Integer ( a numeric value) or Boolean (True or 
False).. This value is automatically populated when a field is selected; if no field is selected, this value is 
blank.

Default The default number used for the selected field. This value is automatically populated when a field is 
selected; if no field is selected, this value is blank.

Reset Click to change the default number used for the selected field. Click Save to save this setting and upload 
it to the database for use as the default by the Graphics Editor. 
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To change a setting, follow these steps:
1. From your host system, open Graphics Parameters.

• Picture Perfect: From the Setup menu, select Graphics Parameters, or select the Graphics 
Parameters icon from the toolbar.

2. If necessary, click the Settings tab.

3. Highlight the name of the setting and double click on the value that you want to change.

4. Enter the new value you want to apply in the Value field.

5. Click Save when you are finished. 

6. Click Upload to upload to the database.

Using the Property Condition Priorities tab

Use this option if you choose to display the symbols on your maps by highest priority. The highest priority 
property/condition displays on the map when icons are overlayed. See Overlay on  page 31 for more 
information on this technique.

Figure 5. Graphics Parameters window: Property Condition Priorities tab 

Table 9. Graphics Parameters: Property Condition Priorities tab fields and description 

Field name Description

Property This column lists all of the defined characteristics for the selected object type, in order of their priority.

Condition This column lists the possible values associated to a property, such as set or reset. 

Move up/Move down Highlight a Property/Condition and click one of these arrows to change the priority order.
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To reorder a property/condition priority, follow these steps:

1. From your host system, open Graphics Parameters.

• Picture Perfect: From the Setup menu, select Graphics Parameters, or select the Graphics 
Parameters icon from the toolbar. 

2. Click the Property Condition Priorities tab.

3. Highlight the name of the Property/Condition. The Move up/Move down arrows on the right are 
enabled.

4. Click the Move up/Move down arrow to change the position of the selected property.

5. Continue to reorder as necessary the Property/Condition combinations to reflect the priority in which 
you want them to display, placing the highest priority first. This procedure only needs to be performed 
once. 

6. Click Save  when you are finished. 

7. Click Upload   to upload to the database.

Using the Operator Settings tab

Figure 6. Graphics Parameters window: Operator Settings tab 

Table 10. Graphics Parameters: Operator Settings fields and description 

Field name Description

Operator Settings

Operator This column lists the operators as defined by their User Name. 

Default Map A default map can be selected to display when an operator opens a viewer window.
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To change an operator setting, follow these steps:

1. From your host system, open Graphics Parameters.

• Picture Perfect: From the Setup menu, select Graphics Parameters, or select the Graphics 
Parameters icon from the toolbar.

2. Click the Operator Settings tab.

3. Highlight the name of the operator and double click in the default map column. A drop down list of 
available maps displays.

4. Select the map you want to use as the default display for this operator.

5. Click Save   when you are finished. This setting is automatically uploaded to the database.

Uploading settings

Settings are stored on the local system, until they are uploaded to the database for centralized storage and 

backup. To upload a setting , click the Upload icon  on the toolbar. 

Note:   Operator settings are automatically uploaded to the database when you click Save

Closing Graphics Parameters

When you change a setting and then close the setting window, the following dialog is displayed:

Figure 7. Close Graphics Maps Parameters

• Yes Saves locally, uploads the changes, and then closes Graphics Parameters.
• No Discards any changes and then closes Graphics Parameters.
• Cancel Keeps Graphics Parameters open.
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This chapter describes how to create a symbol scheme with icons representing 
devices such as doors, readers, digital inputs, and micro controllers.

In this chapter: 

Introduction. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 30
Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 31
About the Symbol Editor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 32
Using the Symbol Editor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 36
Managing Symbol Editor files  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 39

Chapter 4 Creating symbols
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Introduction
This feature allows you to create symbol schemes that represent the various conditions of your devices by 
associating icons for each condition of each device property.

Table 11 lists the steps needed to create a symbol scheme and references where you will find detailed 
instructions to complete these tasks. 

Table 11. Task overview

Associate icons to each condition for each property of each object type. Refer 
to Using the Symbol Editor on page 36 for more information. 

Upload the symbol scheme to the database. Refer to Uploading a symbol 
scheme on page 39 for instructions on how to upload the symbol scheme to 
the database.

Place the symbols on your graphics maps and associate them to the devices 
they represent. Refer to Configuring Symbols on page 52 for instructions on 
how to associate a symbol to a specific device.
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Overview
Use the Symbol Editor shown in Figure 8 on page 32 to associate icons with conditions of properties of device 
types, such as doors, readers, digital inputs, and micro controllers. The icons represent the condition, such as 
set and reset, for each object type property. This collection of icons and specific attributes represents a symbol 
scheme or symbol.

Before you define a symbol scheme, decide the way you want the status of an object type to display on a 
graphics map. You may select either of the following techniques:

Overlay:Technique by which only one property condition is visible at a time, governed by the 
Property Condition Priorities. This results in a less cluttered display but is limited in the level of detail 
included.  

The system provides default sets of icons in multiple colors. For example, you may choose to have a 
gray door icon represent a door device in the initial state and have it replaced with a red door icon 
when a door forced open condition occurs.

Decoration: Technique by which multiple property conditions are visible simultaneously. This 
approach incorporates more detail in the display but requires more recognition on the part of the 
operator and requires more space on a graphics map. 

The system provides two sizes of default icons: 28x28 for the base icons and 16x16 for the smaller 
decoration icons that are place around the base icon. 

See Display using the Overlay technique on page 37 for more information on how to use the default 
icons.

These two techniques can be applied on a per-device basis. For example you can choose to display micro 
properties and conditions by priority but display all door properties and conditions. The way you create your 
symbol scheme depends on the way in which you choose to display this information. See Using the Symbol 
Editor on page 36 for more information. 

Once a symbol scheme is created, use the Upload button to copy it to the database. Once the symbol scheme is 
copied to the database, it is ready to use with the Graphics Editor to create display maps and is also available to 
other users. Refer to Creating graphics maps on page 41 for more information.
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About the Symbol Editor
From your host system, open the Symbol Editor.

• Picture Perfect: From the Configuration menu, select Symbol Editor, or select the Symbol 
Editor icon from the toolbar. The Symbol Editor window shown in Figure 8 displays.

Figure 8. Symbol Editor window

Title bar

Tool bar

Menu bar
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Table 12. Symbol Editor fields and description   

Field name Description

Title bar Displays the name of the window: Symbol Editor 

Menu bar The Symbol Editor menu bar provides access to the following menus: File, Help

For more information, see Table 13 and Table 14.

New Use to create a new symbol scheme. Refer to Using the Symbol Editor on page 36 for more 
information. 

Save Use to save a symbol scheme to the hard drive. To publish the symbol scheme for use with the 
Graphics Editor, it must be uploaded to the database. Refer to Upload and Download for more 
information.

Delete Use to delete a symbol scheme from the hard drive. To delete a symbol scheme from the database, 
refer to Deleting a symbol scheme from the hard drive on page 40.

Upload and Download Use to upload new or modified symbol schemes to the database.

Use to download a symbol scheme from the database to the local computer to make changes. After 
the symbol scheme has been modified and you are ready to publish the changes, click Upload.
Refer to Uploading a symbol scheme on page 39 and Downloading a symbol scheme on page 39 for 
more information.

Existing Symbols Displays a list of previously defined symbol schemes in alphabetical order. 

Symbol Name Use this field to enter a name identifying a new symbol scheme. 
Use up to 128 characters. Symbol names cannot contain any of the following characters: 
\   /   :   *   ?   “   <   >   | 

Base Icon Displays the icon representing the device in its initial condition. This icon displays in the Graphics 
Editor Show Symbols window. Refer to Show Symbols on page 45 for more information.

Browse Click Browse to locate the folder with the base icon you want to use. 

Object Type Use this drop-down list to select an object type, such as Door, Digital Input, Micro, or Reader.

Associations 

Initially Transparent Select this check box to make the symbol for the base icon transparent until an alarm occurs. 

Property Displays the characteristics of the object type selected. For example, if Door is selected, the properties 
include Door Forced Open, Door Held Open, and Door Pre-Alarm.

Refer to Table 15 for a complete list.

Condition Displays the appropriate condition for the property. Refer to Table 15 for a complete list. 

Icon Displays the image icon associated with the condition. Use the Active check box to enable the icon.

Active Click the Active check box and the Attach window displays. Select the graphic image you want to 
represent the condition. Click Attach. A check mark displays to indicate this property is now enabled 
in the symbol. 
When the Active check box is selected, the graphic image can be used when creating graphics maps. 
If you clear the check box to remove the symbol, it will no longer appear on the graphics maps when 
the condition changes.
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Table 13. Symbol Editor File menu

Menu item Description

New Use to create a new symbol.

Save Use to save a symbol to the hard drive. To publish the symbol for use with the Graphics Editor, the symbol 
must be uploaded to the database.

Delete Use to delete a symbol from the hard drive. 

Upload Use to upload new or modified symbol schemes to the database.

Download Use to download a symbol scheme from the database to the local computer to make changes. After the 
symbol scheme has been modified and you are ready to publish the changes, click Upload.

Delete from 
database

Click to display a list of symbol schemes found in the database. Select from the list and click Remove to 
delete the file from the database.

Table 14. Symbol Editor Help menu

Menu Item Description

Online Help Click to launch the online help page specific to Symbol Editor. Click Show to display the Contents pane 
which allows you to navigate the entire Graphics Monitoring and Control online help system.

User Manual Click to open the Graphics Monitoring and Control User Manual in electronic format.
Note: Adobe Acrobat version 5.x or higher must be installed to view the manual online.
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Table 15. Associating Object types, Properties, and Conditions  

Object type Properties Conditions

Picture Perfect

Digital Input Input Condition Reset, Alarm, Cut, Short

Door Door Forced Open Set, Reset

Door Held Open Set, Reset

Door Pre-alarm Set, Reset

Invalid Badge Occurred, Acknowledged

Suspended Badge Occurred, Acknowledged

Lost Badge Occurred, Acknowledged

Unknown Badge Occurred, Acknowledged

Anti-passback Violation Occurred, Acknowledged

Reader Duress Occurred, Acknowledged

Reader Comm Failure Set, Reset

Reader Invalid Badge Occurred, Acknowledged

Suspended Badge Occurred, Acknowledged

Lost Badge Occurred, Acknowledged

Unknown Badge Occurred, Acknowledged

Anti-passback Violation Occurred, Acknowledged

Reader Duress Occurred, Acknowledged

Reader Comm Failure Set, Reset

Micro/Controller Upstream Comm Failure Set, Reset

Downstream Comm Failure Set, Reset

Micro/Controller Placed Offline Set, Reset
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Using the Symbol Editor
Use the Symbol Editor to create symbol schemes. A symbol scheme is a collection of graphic images or icons 
representing each condition of each device property. You select an object type and assign an icon to each 
condition of each property. Before you create a symbol scheme, you need to understand how to use these icons.

Using icons

When creating a symbol scheme, you can select from the default icons provided, or you can create customized 
icons.  

Using default icons

For base icons or those used as overlay icons, select from the default icons located in:
c:\avatar\gmc\<username>\visEditor\icons\base28x28

For the smaller decoration images (those placed on or around a base icon to indicate a property/condition), 
select from the default icons located in:

c:\avatar\gmc\<username>\visEditor\icons\decorations16x16

Using customized icons

Graphics in several formats are supported, including .gif and .jpg. The maximum size for symbol icons is 32 x 
32 pixels. 

Certain image formats, such as .gif, support the concept of transparency. When a transparent image is placed 
on top of the base image, the base image can show through. This technique allows you to use AutoCAD 
drawings or other backgrounds more effectively and is recommended when developing customized icons. 

In transparent images, all background pixels not contributing to the actual image should be transparent. For 
example, if the transparent image is a rectangle, all pixels not on the line forming the rectangle should be 
transparent. Decoration images (those placed on or around a base icon to indicate a property/condition) should 
always be transparent.

Figure 9. Transparent image overlay 

 

In nontransparent images, the background pixels on the interior of the image are not transparent; if desired, you 
can make pixels on the outer edge transparent in order to “size” the image. Base icon images or those that you 
want to place over the base icon, hiding it, should always be nontransparent.

CAUTION:  If you create animated .gif files for use on symbols or maps, there must not be any frame with a “zero” 
delay time, as this results in 100% CPU usage on the client. Should this occur, you need to log off and close 
all browsers in order to recover.

Base icon
Base icon with  
transparent  
image overlayTransparent image
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Figure 10. Nontransparent image overlay 

 

Creating symbol schemes

Create symbol schemes based on how you want to display the status of your devices on graphics maps, either 
by displaying only the highest priority property/condition (Overlay technique) or by displaying multiple 
properties/conditions of a device (Decoration technique). 

Display using the Overlay technique

This technique displays only the highest priority property/condition symbol of a device. This results in a less 
cluttered display but is limited in the level of detail shown at one time. 

1. From your host system, open the Symbol Editor.

• Picture Perfect: From the Configuration menu, select Symbol Editor, or select the Symbol 
Editor icon from the toolbar. The Symbol Editor shown in Figure 8 on page 32 displays.

2. Enter the name of the symbol scheme in the Symbol Name field.

3. Select the type from the Object Type drop-down list. The appropriate properties and conditions for that 
object type are displayed.

4. Click Browse to select the file you want to use as an icon to represent the base icon. For example, for a 
Door, use a gray door image. 

5. Click Attach. The icon displays in the Base Icon window. The Graphics Editor will use this image to 
represent the symbol scheme.

6. Select the Active check box to display the Attach window. Select the image you want to display for 
each condition of each property. The image should be the same size as the base icon image and it 
should NOT be transparent. For example, for a Door Forced Open, use a red door image. 

7. Place the new icon (the red door image) over the base icon (the gray door image).
8. Click Attach. This image displays on the map when an associated device property has that condition 

value. The Active check box displays a check mark indicating this image has been associated with the 
condition.

9. Click Save   when you are finished. If you want to create another symbol scheme, click New   
to clear the information and continue making new selections. 

To create multiple symbol schemes using the same device types, select the symbol scheme you want to use, 

change the name, and click Save  . From the Windows menu, click Exit to close the Symbol Editor 
window.

Base icon Base icon with  
nontransparent  
image overlayNontransparent 

image
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Display using the Decoration technique

This technique displays all alarm state symbols of a device. This approach incorporates more detail in the 
display but requires more recognition on the part of the operator and could take up more space on the map. 

1. From your host system, open the Symbol Editor.

• Picture Perfect: From the Configuration menu, select Symbol Editor, or select the Symbol 
Editor icon from the toolbar. The Symbol Editor shown in Figure 8 on page 32 displays.

2. Enter the name of the symbol scheme in the Symbol Name field.
3. Select the type from the Object Type drop-down list. The appropriate properties and conditions for that 

object type display.
4. Click Browse to select the file you want to use as an icon to represent the base icon. For example, for a 

Door, use a gray door image. This image should NOT be transparent. 
5. Click Attach. The icon displays in the Base Icon window. The Graphics Editor will use this image to 

represent the symbol scheme.
6. Select the Active check box to display the Attach window. Select the image you want to display for 

each condition of each property. For example, for a Door Forced Open, use a red X. The image can be 
any size but it should have a transparent background. You may place this image anywhere relative to 
the base icon, or on top of the base icon.

7. Click Attach. This image displays on the map when an associated device property has that condition 
value. The Active check box displays a check mark indicating this image has been associated with the 
condition.

8. Click Save  when you are finished. If you want to create another symbol scheme, click New   to 
clear the information and continue making new selections. 

To create multiple symbol schemes using the same object type, select the symbol scheme you want to use, 

change the name, and click Save  . From the Windows menu, click Exit to close the Symbol Editor 
window.
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Managing Symbol Editor files
Symbol schemes are stored on the local system until they are uploaded to the database for centralized storage 
and backup. Once the files are uploaded, they are available to use with the Graphics Editor to create maps.

After a symbol scheme has been uploaded to the database, make sure you download the most current version 
before making changes, since the local version may not be up to date.

Refer to the following sections for more information:

• Uploading a symbol scheme
• Downloading a symbol scheme 
• Deleting a symbol scheme from the hard drive on page 40

Uploading a symbol scheme

To upload a symbol scheme to the database, follow these steps:

1. From the Existing Symbols column, select the symbol name you want to upload to the database. 

2. Select File and then Upload, or select the Upload icon  from the toolbar. A window with this 
message displays: Are you sure you want to upload current symbol? 

• If the symbol scheme has already been uploaded to the database, this message displays: Are you 
sure you want to overwrite the database symbol - file name?   

3. Click Yes to upload the symbol scheme to the database for distribution. 

Once a symbol scheme has been defined, it can be used on graphics maps to reflect the state of the device 
types and to issue commands to devices. Refer to Creating graphics maps on page 41 for instructions.

Downloading a symbol scheme

To download a symbol scheme, follow these steps:

1. From the File menu, select Download or select the Download icon  from the toolbar. The window 
shown in Figure 11 displays.

Figure 11. Download window   

2. Use the drop-down list to select which symbol scheme you want to download from the database. 

3. Click OK. The file is copied from the database to your local system.
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Deleting a symbol scheme from the hard drive

To delete a symbol scheme from the hard drive, follow these steps:

1. Select the symbol scheme you want to delete from the Existing Symbols list. The information for this 
record displays.

2. From the File menu, select Delete or select the Delete  icon from the toolbar. A window displays a 
message asking: Are you sure you want to remove this symbol? Click Yes to remove the symbol 
scheme.

This removes the symbol scheme from the local system only. If it has been uploaded to the database 
and you want to delete it, the file must be removed as described in Deleting a symbol scheme from the 
database. 

3. From the File menu, select Exit to close the Symbol Editor window.

Deleting a symbol scheme from the database

To delete a symbol scheme from the database, follow these steps:

1. Select the symbol scheme you want to delete from the Existing Symbols list. The information for this 
record displays.

2. From the File menu, select Delete from database. The Deleting window displays a list of Resources 
Found. 

3. Highlight the symbol scheme you want to delete and click Remove. A window displays a message 
asking: Are you sure you want to remove this symbol? 

4. Click OK to remove the symbol scheme from the database and exit the window. This removes the 
symbol scheme from the database. 

5. From the File menu, select Exit to close the Symbol Editor window.



This chapter describes how to create graphics maps by importing images or 
AutoCAD drawings and associating symbols created with the Symbol Editor to 
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Chapter 5 Creating graphics maps
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Introduction
This feature allows you to design graphics maps of your premises and associate symbols to devices in your 
system. When a condition changes, one or more of the icons will change its appearance based on the condition, 
if configured to do so.

Table 16 lists the steps needed to complete a graphics map and references where you will find detailed 
instructions to complete these tasks. 

Table 16. Task Overview

Create symbol schemes and upload to the database. Refer to Creating symbols on page 29 for more 
information. 

Import an AutoCAD drawing or graphic image, which becomes the background layer in the Graphics Editor. 
Refer to Importing images on page 54 for instructions to import existing image files or drawings.

You can also use the drawing tools to create a graphics map. Refer to Using the Drawing tools on page 49 for 
more information.

Place symbols representing devices such as doors, readers, micros, or digital inputs and associate them to a 
specific database device record. Symbols can be grouped on different layers to improve visibility when viewing 
the completed graphics maps. Add text labels, if needed.

Refer to the following sections:
Creating a graphics map on page 51, 
Configuring Symbols on page 52,

Adding text labels to the graphics map on page 53.

Save file and upload completed graphics map to the database. Refer to Managing graphics map files on 
page 70 for more information.

Build and link maps using the Create Links icon . An icon/image represents the hyperlink. Refer to Linking 
graphics maps on page 60 for more information.

Build and link maps using the Create Hyperlink Area icon . A user defined shape represents the hyperlink. 
Refer to Linking graphics maps on page 60.

Configure a set of devices of the same type to be controlled as a unit, using the Create Command Group icon 

. Refer to Configuring Command Groups on page 66.
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Overview
The Graphics Editor allows you to associate symbols to devices in your system. A symbol scheme identifies 
icons that represent doors, or other device types in various conditions. These icons are associated with a device 
property and condition and when that condition occurs, the appropriate icon displays on the graphics map. 

For example, a symbol scheme with icons representing doors in an alarm state may include a: 

• gray door to represent the base condition
• red door to represent a door held open alarm set condition 
• green door to represent a door held open alarm reset condition 

When an alarm is generated at the specific door, the appropriate icon for the condition displays on the map. 
Refer to Using the Symbol Editor on page 36 for more information.

If you create graphics maps and link them in a chain using alarm links, the link icons on each level show the 
alarm state of the maps in the chain. Refer to Linking graphics maps on page 60.

There are three ways to create a graphics map, which are:

• Create map with the drawing tools provided by the Graphics Editor.
• Using the drawing tools, such as circles, lines, polylines, rectangles, and text entries, you can 

create a site map, or a graphical representation of your facilities. Refer to Using the Drawing tools 
on page 49 for more information.

• Use an existing .jpg or .gif graphics file. 
• Most professional drawing applications usually have the capability to save a drawing in a .jpg or 

.gif format. Refer to Importing .gif, .jpg, or .jpeg images on page 54 for more information.
• Import .dxf drawings created with AutoCAD®. 

• Site maps and drawings with a .dxf extension can be imported if they are saved in AutoCAD DXF 
R12  format (2007 and 2009 are not supported at this time). Refer to Importing AutoCAD .dxf 
drawings on page 55 for instructions.

To achieve the best results in your site map, draw the map as close to the size of the window in which it will be 
displayed. If you are importing a .jpg or .gif graphic image file, size the image to fit the window in which it will 
be displayed. Whenever possible, be consistent and keep all of your displays the same size.   
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About the Graphics Editor
To display the Graphics Editor, follow these steps:

1. From your host system, open the Graphics Editor.

• Picture Perfect: From the Configuration menu, select Graphics Editor, or select the Graphics 
Editor icon from the toolbar.

2. The Graphics Editor window shown in Figure 12 displays.

Figure 12. Graphics Editor window
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Table 17. Graphics Editor elements and description  

Element Description

Title bar Displays the program name, Graphics Editor, as well as the window number.

Menu bar The Graphics Editor menu bar provides access to the following menus: File, Edit , 
Placement , Transform, Utilities, Zoom, Layer, Help
For more information, see Table 18 through Table 25.

Font toolbar Use the drop-down lists to select a font type and font size. The available fonts are 
determined by the workstation where the Graphics Editor is being used to create drawings.
If fonts used in the drawing are unavailable on the workstation where the drawing is 
displayed, substitute fonts are used.

Select the icons to make the font bold  or italic .

Drawing tools Refer to Using the Drawing tools on page 49 for instructions on how to use these drawing 
tools.

Import JPG/GIF File Displays the Open window, which allows you to select a .gif or .jpg file to use as the 
background layer.

Refer to Importing .gif, .jpg, or .jpeg images on page 54 for more information.

Create Link Links two graphics maps together, either to link alarms or simply as a navigational jump. 
The link icon displays on the graphics map when it is viewed with the Graphics Monitor. Click 
it to display the associated map. 
Refer to Linking graphics maps on page 60 for instructions on how to link maps.

Create Hyperlink Area Use the Create Hyperlink Area icon to draw a border around an irregular shape, creating a 
custom hyperlink path on a graphics map.
Refer to Linking graphics maps on page 60 for instructions on how to link maps.

Show Symbols Displays the Symbols window. The Symbols window displays the base icons for each symbol 
created using the Symbol Editor.
Tabs are used to group the symbols with their associated devices such as Digital Input, 
Micro, Reader, or Door. Use the tooltips to identify the symbol name.

Import AutoCAD Drawing Displays the Import AutoCAD Drawing window, which allows you to select a .dxf file to use 
as the background layer.

Refer to Importing AutoCAD .dxf drawings on page 55 for more information.

Create Command Group Configures a group of devices of the same type to be controlled by a single icon. For 
example, you could configure all doors in a building to open in an emergency. 
Refer to Configuring Command Groups on page 66 for more information. 

Status Bar Displays the layer number or name currently active (or visible). 

To change layers, select Layer Settings from the Layer menu. Refer to Working with layers 
on page 67.
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Table 18. Graphics Editor File menu

Menu item Description

New Opens a blank workspace in which you can create a new graphics map.

Open... Opens an existing graphics map file on the hard drive.

Save Saves the file to the hard drive. Graphics maps are stored on the local system until they are uploaded to 
the database for centralized storage and backup. 

Save as... Saves the file to the hard drive under a new name.

Import JPG/GIF 
File

Displays the Open window, which allows you to select a .gif or .jpg file to use as the background layer or 
as an adornment on the map.

Import AutoCAD 
drawing...

Displays the Import AutoCAD Drawing window, which allows you to select a .dxf file to use as the 
background layer.

Upload... Uploads the file to the database. Graphics maps are stored on the local system, until they are uploaded to 
the database for centralized storage and backup. 

Download... Downloads a graphics map from the database. Graphics maps should be downloaded from the database 
before they are edited to ensure you have the latest file.

Delete from 
database...

Displays the list of graphics maps and images found in the database. Select from the list and click 
Remove to delete the graphics map or image from the database. 

Print Displays the Print view window. You can adjust the paper size, format the way the map will appear on the 
page, select the number of copies, and preview the page before printing. 
For more information, see Printing graphics maps on page 83.

Table 19. Graphics Editor Edit menu

Menu item Description

Copy Copies a selected object to the clipboard.

Cut Removes a selected object from your map and place it on the clipboard.

Paste Pastes an object that has been placed on the clipboard to your map.

Delete Deletes any selected objects or text on your graphics map.

Note:  The keyboard Delete key may also be used, however if the symbol palette is open, this key does 
not function. 

Select All Selects all objects and text on your graphics map.

Create Link Inserts an icon to link two graphics maps together. You can then right click the icon to display the 
Configure Link option which allows you to associate the link and apply various settings. 

Create Hyperlink 
Area

Displays a crossbar with which you can draw a border around an irregular shape, creating a custom 
hyperlink path on a graphics map. 

Show Symbols... Opens the Symbols window. This window displays the base icons for each symbol created using the 
Symbol Editor.



Chapter 5
Creating graphics maps

47

Table 20. Graphics Editor Placement menu

Menu Item Description

Grid... Displays a grid which is used to assist in aligning and arranging objects symmetrically. When the grid is 
activated, objects are "snapped" into place when dragged and released. As you draw, rotate, resize, or drag 
objects, they snap to the grid whether it is displayed or not. 

Lock/Unlock This toggle function allows you to lock or unlock one or more selected objects in place so they cannot be 
inadvertently dragged around the drawing space.

Hide/Show This toggle function allows you to hide or show one or more selected objects. You may want to alter your 
graphic map so that some elements are not visible in a particular version based on who is using it. The graphic 
map can always be modified later to restore the view of the hidden object.
To locate hidden objects in a drawing, select Edit , Select All, then Placement , Show. You cannot restore a 
hidden object to view unless it is selected.

Raise When overlapping objects comprise a drawing, select an object and choose Raise to move the selected object 
to the top of the overlapping objects.

Step up When overlapping objects comprise a drawing, select an object and choose Step Up to move the selected 
object up one level in the group of the overlapping objects.

Step down When overlapping objects comprise a drawing, select an object and choose Step Down to move the selected 
object down one level in the group of the overlapping objects.

Lower When overlapping objects comprise a drawing, select an object and choose Lower to move the selected object 
to the bottom of the overlapping objects.

Table 21. Graphics Editor Transform menu

Menu Item Description

Mirror/Flip The Mirror and Flip options reverse an image or selection's orientation along the vertical and horizontal axes:
• Mirror reverses the image or selection horizontally, so that what was the left side becomes the right side, 

and vice-versa. 
• Flip reverses the image or selection vertically, so that what was the top becomes the bottom, and vice-

versa. 

Group/
Ungroup

You can combine several objects into a group so that the objects are treated as a single unit. You can then move 
or transform a number of objects without affecting their individual positions or attributes. 
Select the objects to be grouped or ungrouped. Selecting part of an object and grouping it will group the entire 
object.

Table 22. Graphics Editor Utilities menu

Menu Item Description

Minimize 
styles

Optimizes the use of patterns in a selected portion of a map by using style sharing. The styles or patterns, such 
as lines, arrows, and textures, that are used in the selected objects are reduced to the minimum number of 
styles. 

Minimize all 
styles

Optimizes the use of patterns in a map by using style sharing. All styles or patterns, such as lines, arrows, and 
textures, that are used in a map are reduced to the minimum number of styles. 

Propagate 
styles

Optimizes the use of patterns in a selected portion of a map by using style sharing. The styles or patterns, such 
as lines, arrows, and textures, that are used in the selected objects are reduced to the minimum number of 
styles. These styles are then shared with all the elements in the map that have equivalent styles. 
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Antialiasing Makes the edges of lines appear smoother.

Table 23. Graphics Editor Zoom menu

Menu Item Description

Zoom In/Zoom Out Select Zoom In to magnify the display area, or select specific view size from the Zoom menu.
Select Zoom Out to reduce the display area, or select a specific view size from the Zoom menu.
The default view size is 100%.

Table 24. Graphics Editor Layer menu

Menu Item Description

Create new layer... When the Graphics Editor opens, the drawing area that displays represents layer zero, or the background 
layer. Use this layer to display the building structure or site map. Create additional layers to display 
different objects, such as doors, micros, or inputs. Some site maps may not require multiple layers.
When you select Create new layer, a window displays the layer number, such as Layer 1 in the New Layer 
Name field. You can change the layer name to something more meaningful, such as Access Doors. 

Layer settings... Select one or all of the layers to display. When you are working with multiple layers, you will need to make 
a layer active before you can make changes to the layer. The layer setting feature also allows you to 
rearrange the layers by moving them up or down

Rename layer... Change the name of a layer. Before you rename a layer, you must first select it . 

Remove layer... Remove extra layers. The last layer cannot be removed.
When you select this option, the Select Layer window displays. Use the drop-down list to select the layer 
you want to remove from the drawing.

Move selected 
objects...

Rearrange objects by moving them to another layer. 

When you select this option, the Select Layer window displays. Use the drop-down list to select the correct 
destination layer. This is the location where the objects will be moved.

Table 25. Graphics Editor Help menu

Menu Item Description

Online Help Launches the online help page specific to Graphics Editor. Click Show to display the Contents pane 
which allows you to navigate the entire Graphics Monitoring and Control online help system.

User Manual Opens the Graphics Monitoring and Control User Manual in electronic format.
Note: Adobe Acrobat version 5.x or higher must be installed to view the manual online.

Table 22. Graphics Editor Utilities menu

Menu Item Description
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Using the Graphics Editor

Using the Drawing tools

The Graphics Editor provides drawing tools to create site maps or other graphics maps. 

To use the drawing tools, follow these steps:

1. Select the appropriate icon. You must select a tool each time before moving to the drawing area.

2. Position the mouse where you want to begin drawing. Follow the instructions listed in Table 26 to use 
the tools.

Table 26. Drawing tools description  

Tool Description

Rectangle Use to draw a rectangle or a square.
• To create a rectangle, use the mouse to click and drag to reach the correct size.
• To create a square, click and hold the Shift key while dragging the mouse. 

Circle Use to draw a circle or an ellipse.
• To draw a circle, click and hold the Shift key while dragging the mouse. 
• To draw an ellipse, click and drag the mouse to reach the correct size.

Line Use to draw a horizontal, vertical, or diagonal line.
• Click to begin the line and drag the mouse to the correct location to end the line.

Polyline Use to create a free-form shape.
• Click in the drawing area and begin to move mouse to create the shape. 
• When one side is complete, left-click to change direction. 
• When finished, right-click to complete the shape.

New Path Use to create a set of straight, cubic, or quadratic segments. The Path Tools window displays with four 
segment types: straight line, isometric, two-dimensional, and three-dimensional.

• Left-click to create each point. Right-click to complete the shape.

Text Entry Use to add text to the drawing.
• Click in the drawing area and the Text Input window displays. Enter the text you want to add to the 

drawing and click OK.
• Resize the text by stretching or shrinking the text in the drawing area.

Array Use to draw a grid with four columns and four rows. This can be a square or rectangle shape.
• Click in the drawing area where you want the grid to display and move the mouse until the grid is the 

size you want.
• Resize by stretching or shrinking the grid in the drawing area.

Link Use to draw a connection between objects. Click on a sizing handle of one object and then click on a sizing 
handle of the object to which you wish to link. As you move one of the objects the link remains connected to 
the other object.

Orthogonal Link Use to draw a connection with two or more calibration points between objects. Click on a sizing handle of 
one object, click the first calibration point, continue to click any remaining calibration points, and finally 
click on a sizing handle of the object to which you are connecting. As you move one of the objects the link 
remains connected to the other object.
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Changing Graphic attributes

When you use any of the drawing tools or the Create Hyperlink Area icon  to create a drawing, you can 
change the appearance of the drawing using the Graphics attributes window.

To use the Graphic attributes window, follow these steps:

1. Double-click the drawing to display the Graphic attributes window as shown in Figure 13. If you want 
to select more than one drawing, click and drag in the drawing area to include other drawings. 

2. Select the attributes that you want to apply, such as color, pattern, line, and brightness. Refer to 
Table 27 for instructions.

3. Click Apply All to apply the selected attributes. Click Close when finished.

Figure 13.  Graphic attributes window

Table 27. Graphic attributes elements and description

Element Description

Line Color Click Line Color to display the Edit Line Color palette. Select a line color and click OK.

Fill Color Click Fill Color to display the Fill Line Color palette. Select a fill color and click OK.

Pattern Transparency Click to display the fill color in the drawn image or a shape drawn with the Create Hyperlink Area 
tool.
Click to remove the fill color. When you remove the fill color, only the pattern displays with a white 
background.

Fill Styles Click to apply a pattern to the image. Use Fill Color to select a color for the pattern.

Line Thickness Select the line thickness, from 0 to 6. 

Line Styles Select the line style such as, solid, dotted, or dashed.

Arrow Style Select the type of arrow pattern to apply to the line.

Transparency Factor Use the slider to indicate the brightness of the line and fill color. 100 is the brightest.

Transparency Factor

Fill Color

Line Color

Pattern Transparency

Arrow Style

Fill Styles Line Styles

Line Thickness
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Creating a graphics map

A graphics map is composed of a basic site map and symbols representing devices and their associated 
properties and conditions. 

To create a graphics map, follow these steps:

1. From your host system, open the Graphics Editor.

• Picture Perfect: From the Configuration menu, select Graphics Editor, or select the Graphics 
Editor icon from the toolbar.

2. Using the Graphics Editor drawing tools, create the background layer of the graphics map. 

• If you have an existing map in a .jpg or .gif format, use the Import JPG/GIF File icon  to 
import the map file.  
Refer to Import JPG/GIF File in Table 17 on page 45 for more information on how to do this.

• If you have an existing map in a .dxf format, refer to Importing AutoCAD .dxf drawings on page 55 
for more information.

3. Select the Show Symbols icon  to display the Symbols window as shown in Figure 14.

Note:  Symbol schemes must be created before this step to identify the icons that will be used with the display. If the 
symbols are not displayed, use the Symbol Editor to upload them to the database.

Figure 14. Symbols window

4. Select the appropriate tab to display the symbols. Select the appropriate symbol; using tooltips to 
display the symbol name. 

5. Drag the symbol to the appropriate location on the map, or double-click to drop the symbol in the 
upper left hand corner of the map. Then drag it to the appropriate location.

6. Continue to Configuring Symbols.

Tab
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Configuring Symbols 

Use this option to associate a symbol icon to a specific device record in the host database. 

To associate a symbol icon to a specific device, follow these steps:

1. Right-click on the symbol to display the menu as shown in Figure 15.

Figure 15. Set Association button 

 

2. Click Configure Symbol to display the window as shown in Figure 16. 

Figure 16. Configure Symbol window

3. Use the list to select the device that you want to associate with this symbol. If desired, enter search 
criteria in the Filter: field and click Find to filter the list. Click Save.

4. Continue to Adding text labels to the graphics map.

“Unknown” displays if the 
association is not yet identified.
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Adding text labels to the graphics map 

This feature allows you to add a text label to identify a building name, identify a link to another graphics map, 
or identify a particular symbol icon on the graphics map. 

To add a text label follow these steps: 

1. Select the Text Tool icon  on the Graphics Editor toolbar. The mouse pointer changes to a 
crosshair shape.

2. Click in the drawing area where you want to place the text label.  The Text Input window as shown in 
Figure 17 displays.

Figure 17. Graphics Editor with Text Input dialog

3. Enter the text to use as the label or description of the symbol. Click OK.

4. The text displays on the drawing area with an active border surrounding the text. Select the text and 
move it to the correct position. Use the Font toolbar to change the text attributes.

• Use the Font drop-down list to select the font. 
• Use the Size drop-down list to select the font size.

• Click the Bold icon  to change the font to bold.

• Click the Italic icon  to change the font to italics.

Continue to the next section to save the graphics map.

Font Toolbar

Text Tool Icon



Picture Perfect 4.5 Graphics Monitoring and Control
User Manual

54

Saving the graphics map

To save the file, follow these steps: 

1. From the File menu, select Save. If you are saving the map for the first time, the Save As window 
displays.

Figure 18. Save As window

2. Enter the file name. Click Save. 

Note:  Graphics maps are automatically saved with a .jlx extension in the following directory:  
c:\avatar\gmc\<Login ID>\graphEditor 

Importing images

Importing .gif, .jpg, or .jpeg images

Graphics Monitoring and Control allows you to import .gif, .jpeg, or .jpg files to use as background images for 
your maps. 

To import an image, follow these steps:

1. From the Graphics Editor toolbar, click the Import JPG/GIF icon . The window in Figure 19 
displays.

CAUTION:  If you create animated .gif files for use on symbols or maps, there must not be any frame with a “zero” delay 
time, as this results in 100% CPU usage. Should this occur, you need to log off and close all browsers in order 
to recover.
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Figure 19. Open window

2. Navigate to the folder and select the drawing name you want to import. The name displays in the File 
Name field. Click Open. 

3. The image appears on the map and you can move and resize it, as desired.

4. Using the Layer menu, create a new layer to isolate the imported image as the background layer. See 
Graphics Editor Layer menu on page 48 for more information.

Importing AutoCAD .dxf drawings

Graphics Monitoring and Control allows you to import site maps or drawings created with AutoCAD. Only 
two-dimensional drawings are supported; model information in drawings is not used.When you import an 
AutoCAD drawing, it must be saved in a DXF R12 format. 

You can select which layers you want to import. If you want the site map or drawing to remain as one object, 
no further steps are required. However, if you want to maintain the layers, use the Edit Objects feature after the 
drawing is imported. These layers can be deleted later if not used. Imported layer names cannot be changed. 
Refer to Maintain layers in AutoCAD drawings on page 59 for more information.

Tips on importing AutoCAD .dxf drawings

1. AutoCAD drawing import is performed by first exporting the AutoCAD drawing from within the 
AutoCAD product to a DXF file. The graphics software accepts DXF files formatted to AutoCAD 
version R12.

2. Architectural drawings are not well suited for use as background images on graphics maps. There may 
be extraneous details in the drawing that are not necessary for the background image, but can have a 
significant negative impact on the success of the import. You should create a copy of the original 
drawing and remove any unnecessary objects from the copy, as they can affect the performance of the 
application.. Here are some things to look for:

• There should not be any objects in the z-axis. Graphics maps are two-dimensional, and attempts to 
represent data in the third dimension often produce distorted images. Remove all objects in the z-
axis direction.

• If the original drawing uses a z-axis or 3-D view perspective, change the view to 2-D before 
exporting the drawing to a DXF file format.
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• Locate and remove all outlying objects that are not part of the main drawing. Some of these objects 
may be hidden in different layers and might be difficult to locate. These outliers force the drawing 
scale to be unnecessarily large, which has the effect of reducing the size of the drawing in the 
attempt to fit all of the data within the map viewing area. This is the most frequently occurring 
problem affecting import results.

• Remove all occurrences of cross-hatching or object fills. Although AutoCAD represents these 
objects compactly within the original drawing file, when the drawing is exported the DXF format, 
the output produced by AutoCAD contains many individual lines that AutoCAD draws to achieve 
this effect on the screen. Unnecessary data significantly increases import time (from seconds to 
minutes) and imposes excessive memory requirements for loading the map in the application.

3. The graphics software imports the drawing data into its window at the fixed size specified in the DXF 
file. Therefore, it is extremely important to adjust the scaling of the AutoCAD drawing to a suitable 
size. It may be necessary to adjust the scaling in the original drawing, try the import, re-adjust the 
scaling and try the import again until a satisfactory result is achieved. Also note that before performing 
import operations, you should adjust the size of the Graphics Editor window to about the same size as 
you intend to use for the Graphics Viewer window. This will allow you to determine a good scaling for 
the drawing.

4. The proper use of AutoCAD drawings is based on a producing a series of drawings at increasing levels 
of detail. Because full site plans are so large in scale, a single drawing is not suited for monitoring 
purposes when showing device symbols within rooms. Our recommended approach for using 
AutoCAD drawings is as follows:

• Use your site level drawing as the background for the top-level graphics map. Follow the 
guidelines in step 2 above to achieve a reasonable representation of your site. Place links on this 
graphics map (but not symbols), where these links are connected to your more detailed maps.

Table 28. Troubleshooting AutoCAD import problems

Problem description
Associated tip 
(see above) Solution

Import takes a very long time 2 This is an indication that the DXF file is too large and contains 
unnecessary objects resulting from cross-hatching and object fills. If your 
DXF file size is more than 5 MB (mega-bytes), it is too large and most likely 
contains these types of objects. They should be removed.

The drawing appears 
compressed and occupies only 
a small porting of the graphics 
editor map window after the 
import completes

2 This is an indication that there are outlying objects far removed from the 
relevant data area of the drawing. These outliers should be removed.

The imported drawing is too 
small for placing symbols, 
which obscure important 
details

3 and 4 Decrease the scaling of the drawing, re-export another DXF file and re-do 
the import. You may have to repeat this operation until a desirable result is 
obtained. If your site is complex or has many buildings or other locations 
to be monitored, you should create additional drawings from the original, 
where these new drawings cover only specific areas of the site but at a 
lower level of scaling. The proper approach to using AutoCAD drawings is 
to produce a series of drawings, each showing a greater level of detail and 
then to link them in a manner that allows you to drill down to the lower 
level of maps using the link objects provided by the graphics software. 
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To import an AutoCAD drawing, follow these steps:

1. From the File menu, select Import AutoCAD Drawing or click the Import AutoCAD Drawing icon 

 on the toolbar. The window in Figure 20 displays.

Figure 20. Import AutoCAD Drawings window

2. Navigate to the directory where the .dxf file is stored and select the drawing name you want to import. 
The name displays in the File Name field. Click Import. The Drawing Limits window shown in 
Figure 21 on page 57 displays.

Figure 21. Drawing limits window

• Use the Extents/Limit tab to change the original coordinate system, which is taken from the 
imported .dxf file.

• Use the Ratio/Origin tab to indicate if the aspect ratio of the original drawing should be 
maintained.

The imported image is 
extremely distorted, not visible 
or is missing details from the 
drawing

1 The most likely cause of this problem is that the exported DXF file is not in 
a format supported by the graphics software import feature. If that is the 
case, objects may have been created in a form not recognized by the 
import software and were therefore deleted or improperly constructed 
during the import.

Table 28. Troubleshooting AutoCAD import problems

Problem description
Associated tip 
(see above) Solution



Picture Perfect 4.5 Graphics Monitoring and Control
User Manual

58

• Use the View dimensions tab to convert the .dxf file coordinates to coordinates used by the 
Graphic Editor.

• Use the Other options tab to select the Invert black and white check box. Select this check box to 
change the color attributes. If the text map is not visible, such as a drawing with white ruling lines, 
select the check box to invert the black and white attributes of the drawing.

3. Click OK. The Select Layers to Import window shown in Figure 22 displays.

Figure 22. Select Layers to Import window

4. The Select Layers to Import window lists each of the multiple layers in the drawings. 

• To import all the layers, click Import.
• To import some of the layers, clear the check boxes of the layers you do not want to import. Only 

layers with check marks are imported. The display area reflects the changes in layers as you select 
or clear the check boxes.

5. When the imported drawing is displayed, you can re-import the drawing immediately if necessary. 
Right-click on a path in the drawing or a border. The shortcut menu in Figure 23 on page 59 displays. 
(This menu is not accessible again after you select the Edit Objects option.)

6. Click Import to complete the import operation or Cancel to cancel it.

7. Move and resize the imported drawing, as desired. 

8. Using the Layer menu, create a new layer to isolate the imported AutoCAD drawing as the background 
layer. See Graphics Editor Layer menu on page 48 for more information. 

Clear the check 
box if you do not 
want to import 
the layer.
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Maintain layers in AutoCAD drawings

Use the Edit Objects feature to maintain the layers in the AutoCAD drawings, otherwise the drawing is treated 
as one object.

To maintain the layers in the AutoCAD drawings, follow these steps:

1. Right-click on a border or path in the drawing. The shortcut menu in Figure 23 displays. (Once the 
AutoCAD drawing has been converted using the Edit Objects option, you will have to re-import the 
original drawing to access this menu again.)   

Figure 23. Import DXF menu option

2. Select Edit Objects. If you do not select this option, the drawing remains as a single object on one 
layer. When this option is selected, Graphics Monitoring and Control identifies each layer of the 
imported drawing. 

3. From the Layer menu, select Layer Settings. The window in Figure 24 displays.

Figure 24. Layer Settings with imported and non-imported layers

• To display a layer, select the appropriate Visible check box and the Graphics Editor displays the 
selected layer. 

• To modify a layer, select the appropriate Active check box and the Graphics Editor displays the 
active layer. The remaining layers are visible while you make changes to the selected layer.

• To view all the items on the active layer, select the Edit menu and then Select All. All the items on 
this layer are highlighted.

Layers created in 
Graphics Editor 
display with white 
background.

Imported layers display with a 
yellow background.
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Linking graphics maps

There are two types of links that can be used when linking graphics maps: Alarm hierarchy links and Jump to 
only links. 

• An Alarm hierarchy link allows you to jump from a top level map to a lower level map in the 
hierarchy and it reflects alarm conditions on the lower level graphics maps. If an alarm condition at an 
object on a lower level map occurs, the alarm condition displays on each level of the map that is 
linked. By right-clicking on a link indicating an alarm is present on a lower level map, a list of the 
maps in alarm displays and you can select any of those maps to view.  
 
This type of link should be created from the top level downwards.

For example, if a device on the computer room map is in alarm, both alarm hierarchy links will blink. 
The right-click menu on both links will show the computer room map.

• A Jump to only link is used strictly to navigate between maps and does not reflect associated alarm 
conditions.  
 
This type of link can be created in any direction. 

For example, you can set up your display to jump to/from Building A map to each floor map and also 
between floor maps. 

Building A

Floor 1

Computer Room

Alarm hierarchy link

Alarm hierarchy link

Building A

Floor 1 Floor 2 Floor 3
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Creating Alarm Links

You can create Alarm hierarchy links using the Create Link icon  or the Create Hyperlink Area  

icon . There is no difference in the behavior but the Create Hyperlink Area icon differs in that it allows 
you to draw the link around an irregular shape rather than a point. 

Example 1: Linking multiple maps

The following example uses the Create Hyperlink Area icon  in the Graphics Editor application to draw 
a hyperlink path around an object on a graphics map. 

When a condition changes, the designated hyperlink icon reflects the condition on each level or graphics map 
in the chain as shown in Figure 25. If a condition at an object on a lower-level map changes, the condition 
displays on each level of the map, according to the alarm hierarchy links.

Figure 25. Hierarchal map arrangement

Condition
reflected on three
maps.
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In this example, there are three graphics maps — United States, Florida, and Boca Raton.

• The United States map has three states designated as hyperlink areas, including California, Florida, 
and New York. When a condition changes in Boca Raton, the outline around Florida is configured to 
blink. The operator clicks the icon to display the Florida map.

• Florida is represented by a list of the facilities, including Boca Raton, Miami, and others. When a 
condition changes, the facility name is configured to blink. Operators select the name to view the 
graphics map.

• The Boca Raton graphics map represents the actual facility with associated devices. The door where 
the change of condition occurred is configured to change to a red door icon. 

To create Alarm hierarchy links using the Create Hyperlink Area icon , follow these steps:

1. From your host system, open the Graphics Editor.

• Picture Perfect: From the Configuration menu, select Graphics Editor, or select the Graphics 
Editor icon from the toolbar.

2. From the File menu, select Open. The Open window displays.

3. Select the top-level map you want to use. The file will have a .jlx extension. 

4. Click the Create Hyperlink Area icon  on the toolbar. Move the mouse cursor to the drawing area 
(the cursor changes to a crosshair shape). Click on the drawing area to create the first point on the 
graphics map. 

• Trace the object using horizontal, vertical, or diagonal lines created by clicking to create an anchor 
point and moving the cursor to the next anchor point. 
Use the Zoom menu to increase the size and make it easier to trace an irregular shaped border. 
• When you are finished, right-click to end the path and apply the default graphic attributes. 
• Double-click in the area to display the Graphics Attributes window. Use to adjust border lines 

and change the default attributes, such as color, pattern, line, brightness. Refer to Changing 
Graphic attributes on page 50 for instructions. 

5. Right-click to display the Configure Link button. Click again to display the Hyperlink Area Settings 
window as shown in Figure 26 on page 62. 

Figure 26. Hyperlink Area Settings window 

Browse
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6. Use the Link to Graphics Map list to select the graphics map you want to display when the hyperlink 
image is selected on the Graphics Monitor.

7. Select the Initially Transparent check box if you want the hyperlink border to be transparent when 
there is no alarm condition. Clear the check box to display the hyperlink border.

8. Select how you want the alarm indication to display. The options are:

• Blinking causes the hyperlink area to blink when an alarm occurs. The blink interval setting can be 
configured in Graphics Parameters.

• Custom Alarm Indication Color allows you to select a color. The hyperlink border around the 
image changes to this color when an alarm occurs. 
• Click the Browse button to display the Choose Alarm Color window. Select a color and click 

OK.

9. Click Save.

Example 2: Linking two maps

To create Alarm hierarchy links using the Create Link icon , follow these steps:

1. From your host system, open the Graphics Editor.

• Picture Perfect: From the Configuration menu, select Graphics Editor, or select the Graphics 
Editor icon from the toolbar.

2. Click File and then Open.

3. Select the map file you want to use. The file will have a .jlx extension.

4. Click the Create Link icon  on the toolbar as shown in Figure 27. The icon displays in the upper-
left hand corner of the drawing area.

5. Drag the icon to the appropriate location on the graphics map. 

6. Right-click the Link  icon to display the Configure Link button as shown in Figure 27.

Figure 27. Configure Link button

7. Click Configure Link to display the Link Settings window in Figure 28.

Link Icon



Picture Perfect 4.5 Graphics Monitoring and Control
User Manual

64

Figure 28. Link Settings window

8. Use the Link to Graphics Map list to select the graphics map you want to display when the Link icon 

 is selected on the Graphics Monitor.

9. Click the Alarm hierarchy radio button to indicate that this symbol is to be used for linking alarms.

10. Select the appropriate option to indicate how the hyperlink image changes when an alarm condition 
occurs. The options are:

• Select Blinking if you want the hyperlink image to blink when an alarm condition occurs. The 
blink interval setting can be configured in Graphics Parameters.

• Select Custom Alarm Indication Image if you want to select a different icon to display when an 
alarm condition occurs. Use the Browse button to navigate to the folder with the graphic image 
you want to display on the graphics map to represent the alarm condition.

11. Click Save.

12. In the Graphics Editor window, use the text tool to add a label to identify the link. Refer to Adding text 
labels to the graphics map on page 53.

13. Save your work and upload the new graphics map to the database.

Creating Jump to only links

You can create Jump to only links using the Create Link icon . 

 To create Jump to only links, follow these steps:

1. From your host system, open the Graphics Editor.

• Picture Perfect: From the Configuration menu, select Graphics Editor, or select the Graphics 
Editor icon from the toolbar.

2. Click File and then Open.

3. Select the map file you want to use. The file will have a .jlx extension.

Browse
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4. Click the Create Link icon  on the toolbar as shown in Figure 29. The icon displays in the upper-
left hand corner of the drawing area.

5. Drag the icon to the appropriate location on the graphics map. 

6. Right-click the Link icon  to display the Configure Link button as shown in Figure 29.

Figure 29. Configure Link button

7. Click Configure Link to display the Link Settings window in Figure 30.

Figure 30. Link Settings window

8. Use the Link To Graphics Map list to select the graphics map you want to display when the Link 
icon is selected on the Graphics Monitor.

9. If you want to use a custom image for your links instead of the default link icon , use the Browse 
button to navigate to the folder with the graphic image you want to display on the graphics map to 

represent the link.  There are blue  and green  arrow icons provided in the 
c:\avatar\gmc\<username>\visEditor\icons\base28x28 directory, that can be used as default 
Jump to icons. 

10. Click the Jump to only radio button to indicate that this symbol is to be used for navigation only. The 
Alarm Indication fields are disabled.

11. In the Graphics Editor window, use the text tool to add a label to identify the link. Refer to Adding text 
labels to the graphics map on page 53.

12. Click Save to save your work and upload the new graphics map to the database.

Link Icon



Picture Perfect 4.5 Graphics Monitoring and Control
User Manual

66

Configuring Command Groups

A command group is a group of devices of the same type that can be configured as a single object for the 
purpose of commanding those devices. For example, you can configure all doors in a building to be easily 
opened in an emergency. There are three grouping options available:

• All devices of a type in one or more specified facilities, for example all doors in Facility X. Even if 
doors are added later, you do not need to reconfigure the command group. 

• All devices of a type on a map, for example all doors on the graphics map representing a specific 
building. 

• Custom selection of devices of a type, for example the Main Lobby door on each floor of a building.

To configure a command group, follow these steps:

1. From your host system, open the Graphics Editor.

• Picture Perfect: From the Configuration menu, select Graphics Editor, or select the Graphics 
Editor icon from the toolbar.

2. Click the Command Groups icon  on the toolbar to place a command group icon in the upper left-
hand corner of the map. Then move the icon to the desired location. 

3. Right click the icon and select Configure Command Group. The Command Group window displays.

Figure 31. Configure Command Group window

4. In the Description field, specify a text description for the command group. This description will be 
displayed as a tooltip for the command group icon.

5. If you want to change the default icon, click Custom Command Group Image... to specify an icon to 
represent the command group. Click Reset to restore the default icon.

6. From the Object Type drop-down list, select the object type. Currently this field is restricted to the 
device type, Doors.

7. From the Device Selection drop-down list, choose the method you wish to use to select the devices for 
the command group. 

• By Facilities
• Custom Selection
• All On This Map
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8. Click Save   . 

Working with layers

Layers are defined as single, transparent drawing surfaces that lay on top of one another, much like pages in a 
notebook. Layers give you the ability to see each layer through the others above it, or see each layer 
individually. Layers allow you to move or edit objects on any layer without disturbing the objects on other 
layers.

A graphics map can be created with multiple layers to group devices such as doors, readers, micro controllers, 
or digital inputs. When viewed using the Graphics Monitor, an operator can choose to view all the layers, or 
select a specific layer, such as only doors. This improves visibility by hiding unnecessary details at a critical 
time.

Refer to the following topics for more information:

• Creating a new layer on page 67
• Selecting a layer on page 68
• Renaming a layer on page 69
• Removing a layer on page 69
• Moving objects between layers on page 70

Creating a new layer 

When the Graphics Editor opens, the drawing area that displays represents layer zero, or the background layer. 
Use this layer to display the building structure or site map. Create additional layers to display different devices, 
such as doors, readers, micro controllers, or digital inputs. Some graphics maps may not require multiple 
layers.

To create a new layer, follow these steps:

1. From the Layer menu, select Create New Layer and the window shown in Figure 32 displays with 
the layer number created when you selected this option.

Figure 32. Create New Layer window

2. Change the layer name to something more meaningful than Layer 2, such as Doors. Click OK.

Refer to Removing a layer on page 69 for instructions on how to delete layers.
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Selecting a layer

Use the layer setting feature to select one or all of the layers to display. When you are working with multiple 
layers, you will need to make a layer active before you can make changes to the layer. The layer setting feature 
also allows you to rearrange the layers by moving them up or down.

To select a layer, follow these steps:

1. From the Layer menu, select Layer Settings. The window in Figure 33 displays.

Figure 33. Layer settings window

• To display a layer to view, select the appropriate Visible check boxes and the Graphics Editor 
displays the selected layers. To view all the layers, select all the check boxes. 

• To modify a layer, select the appropriate Active check box. The Graphics Editor displays the active 
layer. The remaining layers are visible while you make changes to the selected layer.

• To view all the items on the active layer, select the Edit menu and then Select All. All the items on 
this layer are highlighted.

• To rearrange the layers, click Move Down or Move Up.

2. Click Close when you are finished making changes.
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Renaming a layer

To rename a layer, follow these steps:

1. From the Layer menu, select Rename Layer and the window in Figure 34 displays. The New Layer 
Name field displays the current layer name.

Figure 34. Rename Layer window

2. Type the new name in the New Layer Name field. Each layer name should be unique and no longer 
than 64 characters. If the name is longer, the extra characters will be truncated. The layer name is case 
sensitive.

Note:  Imported layers cannot be renamed. 

3. Click OK.   

Removing a layer

If you create too many layers or if you do not need all the layers in the graphics map, you can remove the extra 
layers. The last layer cannot be removed.

To remove a layer from your display, follow these steps:

1. From the Layer menu, select Remove Layer. The Select Layer window in Figure 35 displays with a 
drop-down list.

Figure 35. Select Layer window

2. Use the drop-down list to select the layer you want to remove from the drawing.

3. Click OK.   

CAUTION:  When you remove a layer, all of the objects on that layer are also removed.
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Moving objects between layers

When you are working with multiple layers, you may want to rearrange the objects by moving them to another 
layer. 

To move an object to a different layer, follow these steps:

1. First, select the object you want to move.

2. From the Layer menu, select Move Selected Objects. The Select Layer window as shown in 
Figure 36 displays.

Figure 36. Select Layer window

3. Use the drop-down list to select the correct destination layer. This is the location where the object will 
be moved.

4. Click OK.

Managing graphics map files
Graphics maps are stored on the local system until they are uploaded to the database for centralized storage and 
backup. Once the files are uploaded, they are available to use with the Graphics Monitor to view graphics maps 
and associated icons when a condition changes.

When working with symbols, use Download to make sure you are working with the most current symbol files. 

Refer to the following sections for more information:

• Uploading graphics maps on page 70 
• Downloading graphics maps on page 71
• Deleting unused files on page 72

Uploading graphics maps

The Graphics Editor automatically loads the most current symbols from the database every time it opens.

To upload a graphics map to the database, follow these steps:

1. From the File menu, click Open or select the Open icon  from the toolbar, to display the graphics 
map you want to upload to the database.

2. From the File menu, click Upload. The Upload window as shown in Figure 37 displays.
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Figure 37. Upload window

3. Select from the list of Available Facilities and click the right arrow to assign the graphics map record 
to that facility.

4. Click Upload. A message similar to the following displays.

Figure 38. Upload successful

5. Click OK. 

Downloading graphics maps

Graphics maps should be downloaded from the database before they are edited to ensure you have the latest 
file.

To download a graphics map to your local system, follow these steps:

1. From the File menu, select Download or select the Download icon  from the toolbar. The 
Download window shown in Figure 39 displays.
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Figure 39. Download window

2. Select the graphics map from the drop-down list and click OK. The selected map displays in the 
Graphics Editor drawing window.

When you are finished making changes to the graphics map, upload the current file to the database so that 
it will be available to other users.

Deleting unused files

The process of creating symbols and graphics maps is an art, and during that process you may create some files 
that will not be used in your final product. The Graphics Editor provides the capability to remove unused files, 
which includes:

• Displays with .jlx file extensions.
• Images with .jpg, .jpeg, or .gif file extensions.

To remove the files that are no longer needed, follow these steps:

1. From the File menu, select Delete from database. The Deleting window shown in Figure 40 displays.     

Figure 40. Deleting graphics files window

2. Select the Resource Type (Graphics Maps or Images) from the drop-down list. The graphics maps and 
images stored in the database display.

3. Highlight the entries you want to delete and click Remove. 

• Click Refresh to display any entries that may have changed in the database since this window 
displayed.

4. When you are finished removing the files, click X to close the window.



This chapter describes how to use the Graphics Monitor to monitor and respond to 
alarms and to issue commands, such as locking and unlocking doors. You should 
be familiar with using layers in the Graphics Editor application
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Introduction
This feature allows an operator to view graphics maps, monitor and respond to alarms, and issue commands.

Table 29 lists the steps needed to perform these functions and references where you will find detailed 
instructions to complete these tasks. 

Table 29. Task overview

Open a graphics map. Refer to Opening a graphics map on page 78 for more 
information. 

Select the layer to view. Refer to Selecting layers on page 80 for instructions on 
displaying different layers.

Issue commands to devices. Refer to Issuing commands on page 81.

Print graphics maps. Refer to Printing graphics maps on page 83 for more 
information.
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Overview
The Graphics Monitor allows an operator to view graphics maps, monitor and respond to alarms, and issue 
commands. The graphics maps contain symbols, which represent devices such as doors, digital inputs, readers, 
or micro controllers. When a condition changes, the symbol placed on the graphics map changes to reflect the 
new condition. For example, when a door is forced open it can be in one of two conditions — set or reset. Each 
condition of each property is represented on the graphics map by a different symbol, for example: 

• base condition is represented by a gray door icon
• set condition is represented by a red door icon
• reset condition is represented by a green door icon

If you have multiple maps linked together, the link icons on each map reflect the alarm states of the devices on 
the maps to which they are linked.

In addition, a globe icon  displays on the Picture Perfect Alarm Monitor to indicate that one or more 
graphics displays are associated with the device that is in alarm. When you select the globe icon, the Graphics 
Monitor launches the associated graphic display. If more than one map is associated with the device, a list of 
those maps displays from which you may make a selection. See Opening a graphics map on page 78. 
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About the Graphics Monitor
To display the Graphics Monitor, follow these steps:

1. From your host system, open the Graphics Monitor.

• Picture Perfect: From the Monitor menu, select Graphics Monitor, or select the Graphics Monitor 
icon from the toolbar. The Graphics Monitor shown in Figure 41 displays.

Figure 41. Graphics Monitor window

Title bar

Navigation pane

Splitter bar and pointers

Base IconCreate Link Symbol

Text Entry
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Table 30. Graphics Monitor window  

Element Description

Title bar Displays the window title, Graphics Monitor, as well as the window number. 

Menu bar The Graphics Monitor menu bar provides access to the following menus: File, Layer, Help

For more information, see Table 31 through Table 33.

Navigation pane Graphics maps are organized according to their facility. The items that display in the navigation pane are 
determined by an operator’s permission levels and context. 

Initially the facilities are collapsed. 

To expand a facility, click on the +. 

To the left of each map name is an icon that shows the status of the map. If any graphics map is in alarm, 
the icons next to that map and next to the facility appear in red. Even if the facility containing that map is 
collapsed, the icon is red which indicates that a map in that facility is in alarm.

Click on a map to open it . You can also open a map from the menu bar, by selecting File, Open. The 
corresponding facility in the navigation pane will expand accordingly. 

Splitter bar and 
pointers

The Graphics Monitor is divided by a split bar with split pointers, which can be used to change the size of the 
window. Panes can be resized by moving the location of the splitter bar displayed between the panes or 
using the split pointers.

Click the split pointer to move the window left or right of its current position.

Table 31. Graphics Monitor File menu

Menu Item Description

Open... Click to open an existing graphics map file.

Reload Click to download all of the latest information from the database. Reload refreshes all of the existing maps, 
adds any new maps that may have been created, and removes any maps that may have been deleted.

Print Click to display the Print view window. You can adjust the paper size, format the way the map will appear on 
the page, select the number of copies, and preview the page before printing. 

For more information, see Printing graphics maps on page 83.

Table 32. Graphics Monitor Layer menu

Menu Item Description

Show/Hide Layer This toggle function allows you to hide or show one or more selected layers. You may want to alter your 
graphic display so that some elements are not visible in a particular version based on who is using it .

Table 33. Graphics Monitor Help menu

Menu Item Description

Online Help Click to launch the online help page specific to Graphics Monitor. Click Show to display the Contents pane 
which allows you to navigate the entire Graphics Monitoring and Control online help system.

User Manual Click to open the Graphics Monitoring and Control User Manual in electronic format.

Note: Adobe Acrobat version 5.x or higher must be installed to view the manual online.
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Using the Graphics Monitor

Opening a graphics map

You can open a graphics map from the Graphics Monitor or from the Picture Perfect Alarm Monitor.

To open a graphics map from the Graphics Monitor, follow these steps:

1. From your host system, open the Graphics Monitor.

• Picture Perfect: From the Monitor menu, select Graphics Monitor, or select the Graphics Monitor 
icon from the toolbar. 

Note:  If an operator default map is assigned to your operator record, that map opens automatically. See Using the 
Operator Settings tab on page 26.

2. Select one of the following methods of opening a map:

2a. If you do not know in which facility the map is located, from the menu bar, select File and then 
Open. 

The Open window shown in Figure 42 displays. 

Figure 42. Open window

Use the drop-down list to select the graphics map you want to view. Click OK.  

2b. If you know in which facility the map is located, you can open the map directly from the 
navigation pane by clicking on the facility to expand it and then clicking on the map description.

Figure 43. Navigation pane 

The Graphics Monitor automatically downloads the latest copy of the graphics map that exists in the 
database.
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To open a graphics map from the Picture Perfect Alarm Monitor, follow these steps:

1. From the Monitor menu, select Alarm Monitor, or select the Alarm Monitor icon from the toolbar. 

Figure 44. Picture Perfect Alarm Monitor 

2. If an alarm condition exists for a device that is represented on a graphics map, a globe icon  
displays in the Graphics Maps column of the Alarm Monitor.  
Click the globe icon to display the associated map. If more than one map is associated with the device, 
a list of graphics maps displays, from which you may select.
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Selecting layers

Graphics maps can be constructed of different layers with different items on each layer. Use this option to 
select the layers you want to view. One layer may contain only doors, while another layer may contain all the 
micros. Hiding layers reduces the clutter when operators need to focus.

To display a different layer, follow these steps:

1. Select Layer and Show/Hide Layer. The Show/Hide Layer window shown in Figure 45 displays.

Figure 45. Show/Hide Layer window

2. The window displays the layer names (Layer 0, Layer 1, or the name assigned to the layer) with a 
check box to select individual layers. A check mark indicates the layer is visible.

• Select the check box to display a layer. The Show/Hide Layer window remains open to allow you 
to move back and forth between layers.

• Clear the check box to remove a layer from view. If you want to view only Layer 1, clear the Layer 
0 check box.

3. Click X to exit from the Show/Hide Layer window.

Using the zoom feature

Right click on a graphics map to display the following menu options: Zoom In, Zoom Out, and Fit To Window. 
Additionally, if you have a scroll mouse, you can zoom in by rotating the mouse wheel upwards, or zoom out 
by rotating the mouse wheel downwards. The zoom magnifications are:1.0, 1.5, 2.0, 3.0, 4.0, 5.0, 6.0, 7.0, and 
8.0

• Click Zoom In to magnify the map in the viewing area, making the data appear larger.  
The maximum zoom in factor is 8.0.

• Click Zoom Out to pull the map in making the data appear smaller.  
The minimum zoom out factor is 1.0.

• Click Fit To Window to have the entire map fit into the space allocated in the window.
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Issuing commands

The Graphics Monitor allows operators to respond to alarms and issue commands. Different menus with 
different actions display depending on the type of device and its condition, such as Lock Door.

An action may be dimmed if the operation is not allowed. An action may not be allowed if the operator does 
not have permission to perform the action or the action is not supported by the product.

Note:  At the time of this printing, this option is limited to the Door device.

To display the available commands, follow these steps:

1. Select the appropriate graphics map. Refer to Opening a graphics map on page 78.

2. Locate the symbol representing the device.  
 
Right-click the symbol to display the action menu. The window shown in Figure 46 displays the 
device description and a list of actions available to the operator.

Figure 46. Graphics map action menu 

Table 34. Summary of devices and actions

Device Commands

Door Lock Door

Unlock Door With Duration
Unlock Door

Table 35. Lock/Unlock options

Option Description

Acknowledge Door Forced Open Alarm If the device is in an alarm state, selecting this action causes the Alarm Response 
window to display. If the command is not available, it will appear dimmed. 

Lock Door Locks the door until reset by an operator using the unlock command.

Unlock Door With Duration Unlocks the door the number of seconds specified in the drop-down list. Refer to 
Unlock door with duration for more information.

Unlock Door Unlocks the door permanently until changed by an operator.
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Unlock door with duration

To unlock a door for a specified duration, follow these steps:

1. Select Unlock Door With Duration. The window shown in Figure 47 displays.

Figure 47. Lock and unlock door options

2. The default Unlock Door time is 5 seconds. To change the amount of time the door is to remain 
unlocked in this instance, enter an integer in the Value field within the Min/Max range, that is from 1 to 
120 seconds. 

3. Do one of the following:

• To revert to the default, click Reset. 
• To execute the command, click OK.
• To abort the operation, click Cancel.
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Printing graphics maps
To print a graphics map, follow these steps:

1. From the File menu, select Print. The Print view window shown in Figure 48 displays.

Figure 48. Print view window

2. On the Paper tab, use the Paper format drop-down list to select the correct paper size. The 
measurements and margins display for the selected paper format. The default setting is A4.

• Select the unit of measurement to display. Click the appropriate option button to select centimeters 
or inches.

• Select the paper orientation. Click the portrait icon  or landscape icon  to change the 
orientation.

• If you select a custom paper format, enter the paper width and height, and margins for the graphics 
map. Click Default to discard the changes and return to the default settings.

3. On the View selection tab, you can adjust the position of the graphics map on the page. Use the Start X 
and Start Y to change the position of the display. Click Apply when you are finished making 
adjustments.

4. On the Pages tab, you can adjust the position size, resolution, and indicate the number of pages to print 
the graphics map.

5. On the Preview tab, you can preview the page before printing. Make the necessary changes and click 
Print.
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Glossary

This section explains some terms as they apply to Graphics Monitoring and Control. 

Table 36. Graphics Monitoring and Control terms explained

Term Definition

Command Group A configured set of devices of the same type that are to be controlled as a unit. For example, all entry 
and exit doors in a building can be commanded to open in an emergency by a single operator action. 

Condition The possible values for a device property, such as Set or Reset

• Set: Physical alarms that are in the active alarm state.

• Reset: Physical alarms that have been turned off and are no longer active.

• Occurred: Logical alarms that are not yet acknowledged.

• Acknowledged: Logical alarms that have been acknowledged by an operator.

Digital Input A physical sensing device used to monitor an electronic contact connected to a micro controller. There 
are three basic types of digital inputs:

• Door sensors to monitor the door state
• Exit requests to provide access to leave without presenting a badge

Graphics map A collection of images/drawings, symbols, text, links, and command groups that form a graphical 
representation of the physical or logical layout of a site.

Icon A graphic that represents a condition value for an object type.

Image A graphic that represents a layout upon which symbols are placed.

Layer Layers are used to separate the types of devices represented on a map. For example, you can have a 
background layer as well as a layer for micro controllers, another for readers, and another for doors.

Link A bridge or connection between two graphics maps.

Object Type Devices specific to your system, such as micro controllers, doors, readers, or digital inputs

Property A characteristic of a device, such as a door that has been forced open. The properties that display are 
appropriate for the selected object type.

Symbol scheme A collection of graphic images or icons representing each condition of each device property. 

Symbol An instance or use of a symbol scheme on a graphics map. 
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